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Chapter 1
Overview

The 486~VAC-V is a high-performance All-in-One
motherboard offering outstanding features and performance
for building advanced personal computers or workstations.
Based on ISANESA  BUS architecture, this multi-function
board includes built-in IDE and FDC interfaces. The on-board
Cirrus Logic VGA controller is directly linked to the Local BUS,
providing enhanced video performance and Windows
acceleration functions.

Specifications

The 486-VAC-V  motherboard comes with the following
features:

0

0

0

0

0

0

0

0

0

0

Intel 80486SWDWDX2TM  and Intel 80487SXTM  CPU in PQFP
and PGA packages.

VIA VT82C481m  and VT82C495m  PC/AT Chipset.

Supports O/64/1 28/256K  direct-mapped write-back cache
memory.

Supports 1 to 64MB DRAM memory; page mode DRAM
operation.

Shadow RAM.

IMB BIOS.

One 16.bit  ISA expansion slot.

One VESA expansion slot.

Real time clock/calendar.

Built-in SMC651m for IDE HDD and FDD interface.

Overview



l Built-in PDC20230m  local IDE interface.

l Two serial ports and one parallel port.

l PS/2  mouse and keyboard connector.

l Built-in Cirrus GD5426TM  or GD5428m  VGA with 1 or 2MB
Video RAM on board.

l LPM-size board.

_____________________________I__________--~
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Motherboard Layout
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Figure I - 7. Motherboard Layout



System Block Diagram
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Figure I-2. System Block Diagram



Chapter 2
Motherboard Settings

Connector

CNl -
Power connector

CN2 -
PS/2 Keyboard

Pin Out Signal Name

1 Power go
2 +5v
3 +12v
4 -12v

5-8 Ground
9 -5v

10-12 +5v

1 Keyboard data
2 NC
3 Ground
4 v c c
5 Keyboard clock
6 NC.__-_-_

CN3 -
PS/2 Mouse

CN4 -
Serial Port1

CN5 -
Serial Port 2

1 Mouse data
2 NC
3 Ground
4 v c c
5 Mouse clock
6 Ground

1 Data carrier detect
2 Receive data
3 Transmit data
4 Data transmit ready
5 Ground
6 Ready to receive data
7 Request to send data
8 Clear to send
9 Ring indicator

1 Data carrier detect
2 Receive data
3 Transmit data
4 Data transmit ready
5 Ground
6 Ready to receive data
7 Request to send data
8 Clear to send
9 Ring indicator

Table 2- I, Connector Description



Connector Pin Out Signal Name

CN6 - 1 LPT strobe.
Parallel port 2 LPT DO

3 LPT Dl
4 LPT 02
5 LPT D3
6 LPT 04
7 LPT D5
8 LPT DS
9 LPT D7
10 LPT acknowledge
11 LPT busy
12 Paper end
13 Selected status
14 Auto line feed
15 LPT error
16 Initiate printer
17 Select printer

18-25 Ground

CN7 - 1 Red
VGA Connector 2 Green

3 Blue
4 NC

5-8 Ground
9 NC
10 Ground

1 l-12 NC
13 Horizontal sync
14 Vertical sync
15 NC

CN8 - 2 Density selection
FDD Connector 4 NC

6 NC
8 Index detection
10 Select motor A
1 2 ’ Select drive B
14 Select drive A
16 Select motor B
18 Direction control
20 Step pulse
22 Write data
24 Write enable
26 Track 0
28 Write protect
30 Read data
32 Head select
34 Disk change

1,3,5,7,9,11, Ground
13,15,17,19,
21,23,25,27,

29,31,33 c

Table 2- I. Connector Description (Continued)

l.~..-----LY...
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Connector

CN9  -
IDE Connector

Pin Out Signal Name

1 Reset hard disk
2 Ground
3 HDD7
4 HOD8
5 HDD6
6 HDD9
7 HDDS
8 HDDlO
9 HDD4
10 HDDll
11 HDD3
12 HDD12
13 HDD2
14 HDD13
15 HDDl
16 HDD14
17 HDD6
18 HDD15
19 Ground

20-21 NC
22 Ground
23 HD I/O write
24 Ground
25 HD I/O read
26 Ground
27 IOCHRDY
28 HD address latch
29 NC
30 Ground
31 IRQ14
32 IOCS16
33 HD Al
34 NC
35 HD A0
36 HDA2
37 HD chip select 0
38 HD chip select 1
39 HD active
40 Ground

Table 2- 1. Connector Description (Continued)
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Connector Pin Out Signal Name

CNlO  - 1 VP0
8514A Connector 2,4,6,16,18, Ground

20,22,25
3 VP1
5 . VP2
7 VP3
8 Enable video data
9 VP4
10 Enable sync signal
11 VP5
12 Enable video dot clock
13 VP6
14 NC
15 VP7
17 Video dot clock
19 Banking
21 Horizontal sync
23 Vertical sync
24 NC
26 NC

J13 1 HDD Signal
HDD LED 2 Ground

J20 1 LED -
Turbo LED 2 LED +

J21 1 Ground
Turbo Switch 2 Turbo signal

J22 1 Ground
Reset Switch 2 Reset signal

J23 1 Speaker signal
Speaker 2 NC

Connector 3 Ground
4 . vcc

J24 1,2 Power LED
Power LED & 3 Ground

Key lock 4 Keyboard clock
5 Ground

Table 2- 1. Connector Description (Continued)



Jumper

JQ

J16

Function Open

IOCHRDY No
(for Hard Disk) IOCHRDY #

BALE No
(for Hard Disk) BALE #

Close

IOCHRDY

BALE

Jumper Function 1-2 2-3r
J7

J15

Software RTC Clear

A20 Gate

Clear
(For AWARD)

FastA20#

Clear
( For AM)

KB A20

JK3 Address Decode Normal #
(for WEITEK)

TABLE NOTE: # Default

Table 2-2. System Setting

WEITEK
Interface

TABLE NOTE: # Default

Table 2-3. Video Setting

To upgrade display memory to ZMB, install 8 pieces of
DIP 44256-70  DRAM at Ml 1 to M18.
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1-2 3-4
0 (short) 0

1 (open) 0

0 1

1 1

0 0

1 0

0 1

1 1

0 0

1 0

0 1

1 1

0 0

1 0

0 1

1 1

0 0 32

0 0 40

0 0 5 0

1 0 80

1 II 0 II 66.6 II
1 III 0 II 66.6 II
1 II 0 II Test II
0 1 12

0 * 1 16

II
0 II 1 II 25 II

1

1 1 40~__
1 1 50-
1 1 33.3(Default)

1 1 PW_DN

Table 2-4. Clock Setting
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CPU JKl

II 804860X-33 (Default) 2-3

II 804861)X-25 I 1-2

II 80486DX-20 I l-2

II 80486DX2-66 2-3

II 80486DX2-50 l-2

II 80487SX-25 I 1-2

II 80487SX-20 1-2

II 804868X-33 I 2-3

II 80486SX-25 I 1-2

II 80486SX-20 1-2

JK2 JCI JC2 JC3 JC4 OSCl
wr)

2-3 l-2 1-2 ON ON 33.33

1-2 l-2 l-2 ON ON 50.00

1-2 1-2 1-2 ON ON 40.00

2-3 l-2 l-2 ON ON 33.33

1-2 1-2 1-2 ON ON 50.00

1-2 l-2 1-2 OFF OFF 50.00

1-2 1 l-2 1 l-2 1 OFF 1 OFF 1 40.00

2-3 2-3 2-3 OFF OFF 33.33

1-2 2-3 2-3 OFF OFF 50.00

1-2 1 2-3 1 2-3 1 OFF 1 OFF 1 40.00

JC5

(CPU Package)

ON

PGA (default)

OFF

PQFP

Table 2-5. CPU Type Selection

Jumper

JSl

JS2

64K 128K 256K

1-2 2-3 2-3

1-2 1-2 2-3-

Table 2-6. Cache Selection

ISA/VESA Expansion Slot Connector

The motherboard provides one ISANESA  expansion slot
connector. The following list gives a detailed arrangment and
pin outs of this slot. ‘Side A” of the connector are the
component pin outs on the board. “Side B” of the connector
are the solder pin outs on the board.

S.....U......__......_--II---III-------uu~
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Connector
SLOT1

Side A - E
01
02
03

:z
06
07
08
09
10
11
12
13
14
15
16
17
18
19

;:
22
23
24

;:

z
29
30
31
32
33

::
36

z
39

::
42

z
45
46
47
48

2:
51
52
53
54

z
57
58
59

60

IS and pin outs
+12v
Ground
Ground
IOCHCK#
SD7

:::
SD4

%Z
SD1
SD0
IOCHRDY
AEN

Ix
LA77
LA76

:z

%;
SA7 7

%”
SA8

:z
SA5

%$

:AA:
SAO
Ground

Zvnd

szk=#

I%:

k%

%
MEMF?#
MEMW#

%:

%‘:

z:;:

z;:
Ground
Ground
Ground
*LDEVl#
* 7#P-

Side B - l
01
02
03

:z

:;
08
09
10
11
12
13
14
15
16
17
18
19

22:
22
23
24

::
27
28
29
30
31
32

x:
35
36
37
38
39

::
42
43
44
45
46
47

::

55:
52
53
54
55
56
57
58
59
60

Table 2-7. WVVESA  Slot Connector

w and pin outs
+12v
+5v
Ground
Ground

I

_______________________________________________.._..-._-- ______________________________________________I_-
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Connector

SLOT2

Side A - pins and pinouts

01 DATO 102 DAT03

0304 :z%!:
05 DAT07

0607 F%?
08 DATI 3
09 DATI 5

1011 &?!?

12 v c c
1314 !%;;:
15 %%
16

:; :F!F?
19
20 %z:
21
22

;Fz:

;:
ADR26
Ground

25
26

EE

27 v c c
28 ADR20
29 %F%

3031
32

%Fz

33 ADRIO
34 ADR08
35 Ground
36 ;:FI::
37
38

39

kFifFK#

40 v c c
41

42

:::1:

43
44

kz-fd

4 5 ADS#
48 LRDY#
49 LDEVO#

z:
LREQO#  ’
Ground

52 LGNTO#
53

2:
kzfC

56 :::
57 LKEN#
58 #

Side B - pins and pinouts

0102 :%z

0304 F%z
05 DAT08

0607 :F?“:od
08 DATI 2
09 v c c

1011 :;:T;:

12
::

~~~~:

15 %fz
16
17 !%%
18 DAT28
19 DAT30
20 v c c
21 ADR31

Ground
;: ADR29
24
25 %Z

:; EE:
28 ADRIS
:: Ground

31 ~Fz
32 v c c
33

:;
%!1?
ADR09

36 ADR07
37 ADROS
38 Ground

3940 ;FI:;
41 NC

4243 FIkfET#
44 MnO#

W/R#
:z RDYRTN#
49
50 Egnd
51 BRDY#
52

Fk?ST#
g: ID1

:; FFd
57 v c c
58 16#

NOTE: The 120-pin  slot connector pinout has been modified. If
it is used with a standard 120-pin  slot card, it may not
work properly.

Table 2-7. ISANESA Slot Connector (Continued)
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Chapter 3
System Memory

Total Memory Bank 0

1MB 1MB
2MB 1MB
3MB 1MB
4MB 1MB
4MB 4MB
5MB 4MB
6MB 4MB
7MB 4MB
8MB 4MB
12MB 4MB
16MB 4MB
16MB 16MB
17MB 16MB
18MB 16MB
19MB 16MB
20MB 16MB
21MB 16MB
22MB 16MB
24MB 16MB
28MB 16MB
32MB 16MB
33MB 16MB
34MB 16MB
36MB 16MB
40MB 16MB
48MB 16MB
64MB 16MB

Bank 1

1MB
1MB
1MB

1MB
1MB
1MB
4MB
4MB
4MB

1MB
1MB
1MB
4MB
4MB
4MB
4MB
4MB
16MB
16MB
16MB
16MB
16MB
16MB
16MB..-v

Bank 2

1MB
1MB

1MB
1MB

4MB
4MB

1MB
1MB

1MB
1MB
4MB
4MB

1MB
1MB
4MB
4MB
16MB
16MB

Bank 3

1MB

1MB

4MB

1MB

1MB

4MB

1MB

4MB

16MB

Table 3- I. Memory Configuration

NOTE: All memory banks use the 72-pin memory modules.
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/I I 64K I 128K I 256K II

II ALTER RAM I 8Kx8 I 8Kx8 I 32Kx 8 II

II TAG RAM I 8Kx8 I 8Kx8 I 32Kx 8 II

DATA RAM 8Kx8 32Kx 8 32Kx 8

Table 3-2. Cache Configuration Size

Figure 3-l. Cache Bank Location on the Motherboard

--_Y-----Y-P-y__Y_u----~--Y~~~_I__y_~~~Y_y---y--~y-~~
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64K Direct Mapped Cache

Ma p aKKa 1 M3 f’ ~UJ@ ]

M9 f’ N&a ) M4 f aUxa  )

Figure 3-2. 64K Direct Mapped Cache

NOTE: 64K Direct Mapped Cache option is achieved by installing
eight 8Kx8 SRAM (DATA RAM) DIPS at M2 to M5 and M7
to MIO, and one 8Kx8 SRAM (TAG RAM 28 pin) at M6.

~_u__-_u~__--.~_I_~_.~~~-I--~._~--I~-----~~~~_~~~~wu~~----
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128K Direct Mapped Cache

M l  f=]*

M7 i II I*
M8 i1
M9 f nn 1
MlOf===- 1

M6

M2

M3

M4

M5

8Kx8

b 32Kx8 1

Figure 3-3. 128K Direct Mapped Cache

NOTE: 128K Direct Mapped Cache option is achieved by
installing four 32Kx8  SRAM (DATA RAM) DIPS at M2 to
M5 and one 8Kx8 SRAM (TAG RAM 28 pin at M6.



256K Direct Mamed Cache

Ml i no

M 7  i’ 32Kx8

1 * M6 piq

-I I 1

1 M2 p 32Kx8 j

I i I 1

~8 p 32Kx8 ) M3 f 32Kx8 )

Mgbb) M4 f-%&i-l

Ml0 p,,,,-) M5 f?%ii-j

Figure 3-4. 256K Direct Mapped Cache

NOTE: 256K Direct Mapped Cache option is achieved by
installing eight 32Kx8 SRAM (DATA RAM) DIPS at M2 to
M5 and M7 to MIO, and one 32Kx8 SRAM (TAG RAM 28
pin) at M6.

System Memory
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Chapter 4
Award BIOS Setup

System Setup

A SETUP program, builtinto the system BIOS, is stored in the
CMOS RAM that allows the configuration settings to be
changed. This program is executed when:

l User changes system configuration.

l User changes system backup battery.

l System detects a configuration error and asks the user to run
the SETUP program.

After power-on RAM testing, the message below appears:

“TO ENTER S E T U P  B E F O R E  B O O T ,  P R E S S
CTRL-ALT-ESC” or <DEL>  key.

Press “CTRL+ALT+ESC”or <DEL>  to run SETUP. The screen
below appears:

ROM ISA BIOS (VIAOOOOO)
CMOS SETUP UTILITY

AWARD SOFTWARE, INC

STANDARD CMOS SFZI’UP PASSWORD SElTING

BIOS FEATURES SETUP IDE HDD AUTO DETECTION

CHIPSET  FEATURES SETUP HDD LOW LEVEL FORMAT

LOAD BIOS DEFAULTS SAVE & EMT SETUP

LOAD SE?IYJP  DEFAULTS EXIT WITHOUT SAVE

ESC : Quit
FlO:Save&Exit

‘I‘&+  t- :Select  Item
(Shift) lx2 : Color

Time, Date, Hard Disk Trpe

Use 1‘ or &or -+ or +- key to select and press “ENTER” to run
your selection.

Award BIOS Setup



Standard CMOS Setup

The Standard CMOS SETUP has 10 items for setting. Each
item may have one or more option settings. Move cursor to the
desired item for setting. Use the “PgUp”,or “PgDn” keys to
see the options available for the highlighted item.

ROM ISA BIOS (VIAooooO)
STANDARD CMOS SETUF’
AWARD SOFTWARE, INC.

Date (mm:  dd: yy)
Time(bh:mmzss)
DAYLIGHT SAVING

Drive C: User (81mb)
DriveD:Nane(  Omb)
Drive A: 1 .W, 5.25 in
Drive B: 1.44M. 3.5 in

Vi&o : EGA/VGA

Halton:  AllErrors

Sat, May IS 1993
12:37:05
Disabled

CYLS. HEADS PRECOMP LANDZONESEaORS
611

0

I Total Memay : 8192K

ESC : Quit ‘/‘h  + : Select Item PgUp/PgDn/+/ :Modify
Fl:  Help (Shift)F’2  : Change Color F3 :Toggle  Calendar

The Standard CMOS SETUP screen is displayed above.
System BIOS automatically detects memory size, thus no
changes are necessary.‘Press  “F3” to show the calendar.

Daylight Saving

When enabled, this field allows user to set the clock one hour
in advance. When disabled, it subtracts one hour from
standard time. After the changes are made, ‘press “ESC” to
return to main menu.

4 - 2 Award BIOS Setup



BIOS and Chipset  Features Setup

ROM ISA BIOS (VIAOOOOO)
BIOS FEATURES SETUP

AWARD SOFTWARE, INC..

Boot Up System Speed
IDE HDD Block Mode
Gate A20 Option
Typem atic Rate Setting
Typematic Rate (Chars/Set)
Typematic Delay (Msec)
Security Option

: Disabled
: 6

: Disabled
DOOO-D3FFF Shadow : Disabled
D4000-D7FFF Shadow : Disabled
D8000-DBFFF Shadow : Disabled
DCOOO-DFFFF Shadow : Disabled
EOOOO-E3FFF  Shadow : Disabled
E4000-E7FFF  Shadow : Disabled
ENlOO-EBFFF  Shadow : Disabled
ECOOO-EFFFF Shadow : Disabled

-_) t- : Select Item
PgUp/PgDn/+/- : Mod@

(Shift) F2 : Color

ROM ISA BIOS (VIAOOOOO)
BIOS FEATURES SETUP

AWARD SOFTWARE, INC..

ISA Command Delay
-ISA Wait State

l/O Recovery Time
Extended ALE
Decoupled Refresh
Relocate 256f384K
Video BIOS Cacheable
System BIOS Cacheable

DRAM Timing Control

: Nbrmal
: Normal
: Disabled
: Dirabled
: Enabled
: Disabled
: Enabled
: Enabled

: Fact
Cache Timing Control : Turbo

Esc : Quit T-L+ t- : Select Item
Fl : Help PgUp/PgDn/+/- : ModifL
F5 : Old Valuer (Shift) F2 : Color
F6 : Load  BIOS Defbults
F7 : Load Setup Defiurlti

NOTE : Users are not encouraged to run the BIOS and Chipset
Features Setup items. Your system should have been
fine-tuned before shipping. Improper Setup may cause
system to fail. Consult dealer before making any changes.
Default values of the various Setup items on this chapter may
not necessarily be the same ones shown on your screen.

Award BIOS Setup



Load Setup Default

Selecting this field loads the factory defaults for BIOS and
CHIPSET FEATURE which the system automatically detects.

Load BIOS Default

BIOS defaults contain the most appropriate values of the
system parameter that allows minimum system performance.
The OEM manufacturer may change the defaults through
MODBIN  before the binary image burns into the ROM.

Password Setting

Seiect this function to create a password. Type your
password up to eight characters and press “Enter”. You will
be asked to confirm the password. Type the password again
and press “Enter”. You may also press “Esc” to abort the
selection and not enter a password. To disable your
password, press “Enter” when you are prompted to enter
password. A message appears, confirming the password has
been disabled. When the password is disabled, the system
boots and you can enter SETUP freely.

Security Option

If you select System under this field, you will be prompted for
the password every time system is rebooted or any time you
try to enter SETUP. If you select Setup, you will be prompted
only when you try to enter SETUP.



Standard CMOS SETUP

AMI  BIOS SETUP PROGRAM - STANDARD CMOS SETUP
0 1992 American Megatrends Inc., All Rights Reserved

Date (mn/date/year) : Fri, Jun 11 1993 Base memory : 640 KB
Time (hour/min/sec) : 11 :32:03 Ext. memory : 3072 KB

Cyln Head WPcom  Ozone  Sect Size
Hard Disk C: Type : 17 977 5 300 977 17 41 MB
Hard Disk D: Type : Not Installed
Floppy Drive A: : 1.2MB,  5’14”
Floppy Drive B: : Not Installed
Primary Display : VGA/PGA/EGA
Keyboard : Installed

’ Month : Jan, Feb, . . . Dee
Date : 01, 02, 03, . . . 31
Year : 1901,1902, . . . 2099

ESC : Exit A+? : Select F2/F3  : Color PgUp/PgDn : Modify

The standard CMOS SETUP screen is shown above. System
BIOS automatically detects memory size, thus no changes
are necessary. After the changes are made, press “Esc” to
exit. The SETUP program is completely menu driven. Use the
arrow keys to select an entry; “PgUp/PgDn“ keys to change
an entry; and “Es&  key to exit. Help messages are displayed
in a window on the screen when Alt-Fl is pressed.



Chapter 5

AMI BIOS Setup

System Setup

A SETUP program, built into the system BIOS, is stored in the
CMOS RAM that allows the configuration settings to be
changed. This program is executed when:

l User changes system configuration.

l User changes system backup battery.

l System detects a configuration error and asks the user to run
the SETUP program.

After power-on RAM testing, the message below appears:

“Press <DEL>  if you want to run SETUP.”

Press “DEL” to run setup or do nothing to bypass. If the “DEL”
key is pressed, the following screen is displayed:

AM1 BIOS SETUP PROGRAM - BIOS SETUP UTILITIES
63 1992 American Megatreads Inc., All Rights Reserved

STANDARD CMOS SETUP
ADVANCED CMOS SETUP

AUTO CONFIGURATION WITH BIOS DEFAULTS
AUTO CONFIGURATION WITH POWER-ON DEFAULTS

CHANGE PASSWORD
AUTO DETECT HARD DISK

HARD DISK UTILITY
WRITE TO CMOS AND EXIT

DO NOT WRITE TO CMOS AND EXIT

Load BIOS Setup Default Values for Advanced CMOS and Advanced CHIPSET  Setup

ESC  : Exit k+ ‘?’  Se1 FuF3 : Color FlO : Save & Exit

Use & and ? keys to select and press “Enter” to run your selection.

AMI  l?IOS  Setup



Standard CMOS SETUP

AM1 BIOS SETUP PROGRAM - STANDARD CMOS SETUP
0 1992 American Megatrends Inc., All Rights Reserved

Date (mn/date/year) : Fri, Jun 11 1993
Time (hour/min/sec) : 11 :32:03

Hard Disk C: Type : 17
Hard Disk D: Type : Not Installed
Floppy Drive A: : 1.2MB, 5’/4”
Floppy Drive B: : Not Installed
Primary Display : VGA/PGA/EGA
Keyboard : Installed

Month : Jan, Feb, . . . Dee
Date : 01, 02,03, . . . 31
Year : 1901,1902, . . . 2099

Base memory : 640 KB
Ext.  memory : 3072 KB

Cyln Head WPcom  IZone Sect Size
977 5 300 977 17 41 MB

Sun Mon Tue Wed Thu Fri Sat
26 ;7 ;8 259 30 31 1

; 10 11 12 6 13 7 14 8 15
16 17 18 19 20 21 22
g :4 $5 $6 27 4 ;8 ;9

ESC : Exit &+‘? : Select F2/F3  : Color PgUp/PgDn : Modify

The standard CMOS SETUP screen is shown above. System
BIOS automatically detects memory size, thus no changes
are necessary. After the changes are made, press “Esc” to
exit. The SETUP program is completely menu driven. Use the
arrow keys to select an entry; “PgUp/PgDn“ keys to change
an entry; and “Esc” key to exit. Help messages are displayed
in a window on the screen when Alt-Fl is pressed.
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Advanced CMOS SETUP

AM1 BIOS SETUP PROGRAM - ADVANCED CMOS SETUP
Q 1992 American Megatrends Inc., All Rights Reserved

Typematic Rate Programming : Disabled
Typematic Rate Delay (msec) : 500
Typematic Rate (Chars/Set) : 15
Mouse Support Option Enabled
Above 1 MB Memory Test Disabled
Memory Test Tick Sound Enabled
Hit <DEL> Message Display : Enabled
Hard Disk Type 47 RAM Area : 0:300
Wait For <Fl>  If Any Error : Enabled
System Boot Up Num  Lock O n
Floppy  Drive Seek At Boot I Enabled
System Boot Up Sequence A:, C:
System Boot Up CPU Speed : High
External  Cache Memory Enabled
Internal Cache Memory Enabled
Password Checking Option : Setup
Video ROM Shadow COOO, 32K : Enabled
Adaptor ROM Shadow COOO, 32K : Disabled

Esc : Exit A-+? : Se1  (Ctrl) PgU

Adaptor ROM Shadow DOOO,  32K :
Adaptor ROM Shadow DSOO,  32K :
Adaptor ROM Shadow EOOO,  64K :
Boot Sector Virus Protection :
BIOS Cacheable Option
Video Cacheable Option
256K Relocate Option
ISA Bus Command Delay
ISA Slave Wait States
I/O  Recovery Time
Extended ALE
Decouple Refresh
FAST A20 PORT 92H
COM 1 Select
COM2 Select
Parallel port address
IDE Select
FDC Select
Local IDE Drive Select

Disabled
Disabled
Disabled
Enabled
Enabled
Enabled
Disabled
Disabled
4 w/s
Disabled
Disabled
Enabled
Enabled
Enabled
Enabled
0378H
Enabled
Enabled
Disabled

/PgDn : Modify Fl : Help F2/F3 : Color
F5 : Old Values F6 : BIOS Setup Defaults F7 : Power-on Defaults

1

Moving around the Advanced CMOS Setup program shown above
is similar to moving around Standard CMOS Setup. Users are not
encouraged to run Advanced CMOS Setup program. Your system
should have been fine-tuned before shipping. Improper setup may
cause the system to fail, consult your dealer before making any
changes.

NOTE : Default values of the various Setup items on this
chapter may not necessarily be the same ones shown on your
screen.

u_yy---____Y__-SW~-__1--~~-1___y_yIII__u_I___u____

AMII  BIOS Setup S - d





Chapter 6

UTILITY and DRIVERS

The instructions in this chapter assume that you understand
elementary concepts of MS-DOS. Before you attempt to install
any drivers, you should know how to format a diskette, copy
and delete files, and understand MS-DOS directory structure.

You should have made backup copies of the ori
and should be using the backu p ones.

ginal diskettes

The 486.VAC-V  supplies drivers for DOS and Windows-based
programs. These drivers will help you utilize and enhance your
system’s video subsystem. Each drivers diskette contains a
README file giving information on the diskette. Read the file
first by using any word processor in the non-document or
ASCII mode.

The installation utility is provided to facilitate the smooth
installation of the display drivers. The installation program is
menu-driven and allows you to select and install only those
display drivers for software and application currently in use.

It is important to note that some display drivers need to have
the associated vendor’s .application  program already installed
on the system prior to loading the VGA display drivers. In other
cases, the loading of the display driver may be an integral part
of the vendor’s product installation process. Please review the
driver product section below for specific instructions prior to
running the installation program.

The VGA card is supplied with software drivers for the
following application programs:

. 3D Studio 1 .x/Z.0

. AutoCAD  9/l  011  l/l 2

l AutoShade  1.x/2.0

l AutoSketch  3.x

l Framework 2/3
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. GEM 3.0

. Lotus I-2-3 2.x/3.0/3.1

l MS Windows 3.013.1

. MS Word 5.0

l OS/2 R. 2.0

l Ventura Publisher 2.x/3.0

l WordPerfect 5.0/U

l WordStar 597.0

l WordStar 2000 V. 3.5

The installation utility is located on the diskette labeled Disk
1. To install the desired display drivers and utility, insert the
diskette into the A: drive and type

A : [Enter]
INSTALL : [Enter]

Follow the instructions on screen to install the listed display
drivers. At any time you may press [Esc] to abort the
installation process and go back to DOS. Selected drivers are
simply copied to the specified disk and directory.
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Clmode

The Clmode utility allows the user to define the type of monitor
attached and set the video modes supported by the VGA.

Using Clmode’s  Menu-driven Interface

At the DOS prompt type: CLMODE [Enter]

The main popup window consists of a number of buttons. Each
button represents a different option or menu. The underlined
letter of a button name specifies the hot key combination for
that item. For example, press the [Alt] and the underlined letter
keys simultaneously or just the underlined letter key to select
an option.

NOTE: If you intend to use a mouse with Clmode, then a mouse
driver should first be installed prior to running the Clmode
utilitv.

Available Video Modes

Select the Video Mode button. The Video Mode Preview
window displays all the modes supported according to the
monitor type attached, and the amount of video memory
present. This list of video modes tells you which are available
in your current configuration for use with extended resolution
drivers. To see what different video modes look like on your
monitor, select the Preview button. After each test screen is
displayed, press [Enter] or the left mouse button to see the
next video mode. if you do not want to see any more video
modes press [Esc] or the right mouse button will return you to
the Video Modes Preview window.

The information in the main window displays the VGA
controller type, the BIOS version number and the amount of
video memory present.
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Getting Help

Clmode provides Help for the following items: Monitor Type,
Video Mode Preview, Mouse, Keyboard and About Clmode.
The Monitor Type help window explains the different
capabilities of each monitor type. The Video Mode help
window defines the information given in the Video Mode
window. The Keyboard and Mouse help windows explain how
to use the keyboard and the mouse to make selections. The
About window displays the copyright message and the Clmode
version number.

Exiting the Clmode

To

0

0

exit Clmode at any time, choose any of the following:

Press [Alt] and [F4]  keys simultaneously.

Click the left mouse button on the system button of the main
window (i.e., The top left corner button of the window which is
shown as a dot).

0 Select the Exit button.

When the Clmode utility exits, the current video mode, monitor
type, and VGA refresh rate will be displayed.
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Using Clmode’s Command Line Options

When command line options for CLMODE.EXE are given at
the DOS prompt, the menu-driven windows will not be
displayed. Instead, monitor type, video mode and refresh rate
will be set at the DOS prompt. The command line options for
CLMODE.EXE are:

CLMODE [[modenumJ[+*-]]  [m[montype] I t6=x t8=x
t1 =x t2=x]
[modenum] mode number
[+*-I + selects 400 lines (default)

* selects 350 lines
- selects 200 lines

[montype] monitor type
tG=x(Hz)  640x480 @ (0 =60,1 =72)
tB=x(Hz)  800x600 @ (0 =56,1 =60,2 =72)
tl=x(Hz) 1024x768 @ (0 =87i,  1 =60,2 =70,3 =72)
tP=x(Hz)  1280x1024 @ (0 =87i, 1 =Not  available)

For example, to select mode 3 for a Super VGA monitor
(montype 2), type the following command at the DOS prompt:

CLMODE 3+ m2 [Enter]

To select custom monitor timings with 640x480 at 60Hz and
800x600 at 72Hz refresh type:

CLMODE t6=0 t8=2 [Enter]

Typing an invalid option will display the command line help
text. Typing [S] as a command line option will display the
current Clmode  settings.

Software Drivers

Windows 3.0/3.1

1. Exit Windows.

2. From the DOS Prompt (e.g., C:\>)  change the directory to
the Windows directory (e.g., CD \WlNDOWS).

3. Type “setup” at the MS-DOS prompt.
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4.

5.

6.

After setup has executed you will be presented with a
screen which shows the current Windows configuration.
Move the highlighted selection bar to the Display entry.
Press [ENTER].

A screen which lists the available display adapters which
you may select for use with Windows will be presented.
Move the highlight bar down to the entry marked “other
(Requires disk provided by a hardware manufacturer)“.
Type in the source drive of the Windows 3.0/3.1  Drivers
diskette.

Select the desired screen resolution and press Enter.
Setup will copy files from the diskette into your Windows
directories. You may be prompted for the “Driver Disk (\files
subdirectory).” When this happens, enter A:\ if this diskette
is in the A: drive.

If you see the message “Problem with disk drive A:” and the
installation disk is in drive B, press ESC twice, and re-enter
“B:” in the space provided.

7. When Setup is complete, you are returned to the MS-DOS
prompt. Type win to start Windows.

AutoCAD 9/10/11/12

1. Insert the Display drivers diskette into Drive A: (or B:).

2. Run the installation program (INSTALL.EXE), and choose
the option for the Autodesk  / AutoCAD drivers and specify
the drive and directory where you want them copied to
(such as C:\ACAD\DRV).
Since the start-up is a little bit different for AutoCAD
Release 12 than it is for older versions, please follow the
instructions for the version of AutoCAD you will be using
TurboDLDCIassic  with.

To configure AutoCAD  12:

1. Begin AutoCAD with the reconfigure switch by typing
ACAD -R [Enter].

2. Choose option 3, Configure Video Display from the
AutoCAD configuration menu.

6-6 UTILJTY  and DRIVERS



3. Type Y at the Do you want to select... message to display
the available video options for AutoCAD.

4. Select TurboDLD Classic by Panacea Inc. from the list of
display options.

N O T E :  If you chose to install TurboDLDClassic into a
sub-directory other than ACAD\DRV, be sure to modify
the ACADDRV environment variable to include that
sub-directory. Otherwise, the TurboDLDClassicselection
will not appear in the list of available drivers.

To configure AutoCAD 1 l/386:

1.

2.

Run the FASTACAD.BAT that was copied to the
TurboDLD Classic sub-directory by typing:

C:\TURBODLD\FASTACAD [Enter].
The above example shows that TurboDLDClassic was
installed on drive C: in the TURBODLD sub-directory.

Start AutoCAD  and reconfigure it to use TurboDLDClassic
by selecting option 5, Configure AutoCAD from the
AutoCAD  main menu. From the next menu, select option 3,
Configure Video Display. Choose Item 1, P386 ADI
4.0/4.1 (Rll) as your display device. (For more
information, see your AutoCAD ‘Installation and
Performance Guide. ‘)

GEM 3.0

To install the GEM drivers the first step is to create a diskette
file known as the GEM driver pak.

1. Using the standard DOS FORMAT utility, format a blank
diskette by inserting it in drive A and typing the following:

FORMAT A: N [Enter]
The DOS format utility will then prompt for the volume label
by displaying:

Volume Label? (11 characters max) Press Enter for
none. .

At this prompt, type the following volume-label name in
upper case:

GEM DRIVRPK  [Enter].
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2 .

3 .

4 .

5 .

6 .

7.

8 .

9 .

Using the DOS COPY utility, copy the following files from
the GEM/3 system master diskette (comes with GEM/3) to
the newly formatted GEM DRIVRPK diskette. Type the
following sample commands assuming that the GEM/3
system master diskette is in drive A: and the GEM
DRIVRPK diskette is in drive B:

COPY A:GEMVDI.EXE B: [Enter]
COPY A:MDGEM?.SYS B: [Enter].

Insert the drivers diskette into Drive A:. Run the installation
program (INSTALL.EXE), and choose the option for the
GEM/3 drivers and specify the drive and directory where
you want them copied to (such as B:\). GEM/3 requires that
the drivers be installed from the root directory of a floppy
disk in drive A:. Be sure to install the drivers to the root of
drive A: or drive B: and then place the diskette in drive A:
before proceeding.

Install GEM/3 (following the instructionsprovided in the
product’s manual), selecting the standard IBM VGA Color
(IBM PS/2)  driver.

After successfully completing installation, insert the GEM/3
System Master Disk in drive A.

Move to drive A by typing A: [Enter]. Please note that you
must install from the A: drive.

Then type GEMSETUP  [Enter].
Follow the GEM/3 installation instructions up to the
CHANGE EXISTING CONFIGURATION stage. When
prompted for a screen driver choice, highlight:

OTHER (DRIVER PACK).

When prompted to insert a screen driver into drive A, insert
the newly created GEM DRIVRPK diskette.

Select one of the following:
Cirrus Logic VGA 16 Color 800x600
Cirrus Logic VGA 16 Color 1024x768.

lO.Continue  with the remainder of the installation.
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Lotus l-2-3 2.x

1. Run the installation program (INSTALL.EXE), and choose
the option for the Lotus l-Z-3 and specify the drive and
directory where you want them copied to (such as
C:\LOTUS).

2. From within the Lotus sub-directory type:
INSTALL [Enter]

3. From the next menu, select Advanced Options for Lotus
1-2-3 V2.2 or Change Selected Equipment for Lotus 1-2-3
V2.3.

For V2.2, select Add New Drivers to Library and go to
step 3. For V2.3, select Modify Current Driver Set and go
to step 6.

V. From the next menu, select

6. From the next menu, se I
resolution configurations.

Modify Current Driver Set.

ect one of the display and

7. From the next menu,‘select Return To Menu.

8. From the next menu, select Save Changes.

9. Enter the name you have selected for the driver set. We
recommend that the driver set name reflect or include the
driver’s resolution (e.g., 132x43)

NOTE: The default driver set name assigned by the program is
123.SET.

You may create multiple driver sets with different display
resolutions. To run Lotus l-2-3 with a specific driver set, type:

123 SETNAME [Enter]
where SETNAME  is the name of the desired driver set.
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Lotus l-2-3 3.0/3.1

1.

2.

3.

4.

5.

6. Select Modify Current DCF, or Choose another DCF to
modify, according to your preference. The following
procedure is valid for either selection.

7. Select Change Video Display. This will present you with a
list of all the display types provided with the l-2-3
distribution, with two additional choices. GD542xlOO
Column Display (800x600 resolution) supports 100x31,
100x42, and 100x75  16 color modes. GD542x128  Column
Display (1024x768 resolution) supports 128x40, 128x54,
and 128x96 16 color modes. Select a-resolution that best
meets your requirements.

It is assumed that Lotus 3.0 or 3.1 is already installed on
your hard disk, using the standard Lotus installation utility.
To install this driver, make the directory containing l-2-3
V. 3.0 the current directory. For example, if l-2-3 is in the
directory named 123R3,  then type the following command:

CD \123R3  [Enter].

Look for file INSTALL.DDF, a text file used by the l-2-3
installation utility, containing information on each of the
drivers and modes of operation. If you have been using a
driver supplied with .another  graphics adapter, you may
want to make a backup copy of the lNSTALL.DDF file
currently in your l-2-3 directory.

COPY INSTALL.DDF  INSTALL.BAK [Enter]

Run the installation program (INSTALL.EXE), and choose
the option for the version of Lotus 1-2-3 that you *are  using
and specify the drive and directory where you want them
copied to (such as C:\l23R3). If the INSTALL.DDF has
been copied to a backup file (see step 2 above), answer
YES to the prompt to confirm overwriting the file.

Run the Lotus installation utility by typing:
INSTALL [Enter].

Select Change selected equipment from the list.

NOTE: If you are currently using another driver supplied with a
graphics board, it may be necessary to choose First-time
installation.
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8. After your selection is made, choose the Save Changes
option from the menu.

NOTE: When some high-resolution modes are selected, a
message may appear asking for the drive letter of the
floppy disk. Before entering the drive letter, insert the
disk that is requested in the floppy drive. After inserting
the disk, you may enter the drive letter containing that
diskette.

l

MS Word 5.0

The high resolution Microsoft Word 5.0 display driver supplied
with your VGA supports both high resolution text and graphics.
When using a Microsoft Mouse with the driver, please ensure
that your mouse driver version level is 7.0 or above.

1. If you have not already done so, install Microsoft Word onto
your computer system. Follow the instructions supplied
with Word. When asked for a screen display type, choose
IBM Video Graphics Array (VGA).

2. Run the installation program (INSTALL.EXE), and choose
the option for the Microsoft Word drivers and specify the
drive and directory where you want them copied to (such
as C:\WORD5).

NOTE: To use the new drivers they must be copied to the same
directory as Word. Otherwise, they must be copied to the
Word directory before they can be used. .

3. INSTALL.EXE will copy two screen drivers:
SCREEN8.VID  for 800x600 graphics resolution
SCREEN.VID  for 1024x768 graphics resolution.

The driver to be used must be named SCREEN.VlD.  When
a file is renamed this, it will overwrite the existing display
driver. If you wish to preserve the original, it should be
renamed or copied prior to installation of the new drivers.
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4.

5.

The new driver is now installed, and to use it, run Word as
you normally would. To view and change the screen
resolutions, select Options, move the cursor to display
mode, and press [Fl]. Choose the desired screen
resolution from the list presented.

A sub-menu appears, listing all the choices of resolutions
supported by the text driver. Select the desired resolution.

OS/2 R. 2.0

16 Color Drivers

This installation guide assumes the user to be familiar with the
mouse interface of the OS/2 2.0 Desktop Shell environment.

1. Save a copy of the DISPLAY.DLL in \OS2\DLL.  If you are
currently running OS/2 2.0, open a DOS session by double
clicking on a DOS Full Screen icon from the OS/2
Command Prompts folder. The Command Prompts icon is
in the OS/2 System folder. Move to the \OS2\DLL  directory
by typing at the DOS prompt CD \OS2\DLL [Enter].
Type COPY DISPLAY.DLL IBMVGA.DLL /B [Enter] at the
DOS prompt to make a backup copy of the DlSPLAY.DLL
If you are currently running MS-DOS, follow the above
steps for a DOS session to make a backup copy of the
DISPLAY.DLL.
Return to the root directory by typing CD\ [Enter] and
create a subdirectory in your OS/2 drive.
If you intend to install the 16 color drivers:
At the DOS prompt type md CLIGDRV [Enter].
Type C:\OS/2\BOOT  OS/2 [Enter] to boot OS/2 to continue
with the installation.

2. Invoke OS/~‘S Device Driver Install utility from System
Setup in the System Folder. This copies the device drivers
from the Driver and Utilities for OS/2 diskette to the hard
disk.
Insert the Drivers and Utilities for OS/2 diskette into drive
A:.
Double click on the Device Driver Install icanintha  System
Setup folder. System Setup is in the OS/2 System folder.
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Click on the Install button from the OS/2 2.0 Device Driver
Installation pop up window. The Select Device Drivers pop
up window displays a list of device drivers.

To assist in determining what capabilities your monitor
has, refer to the section on Clmode. Select the device
driver to be installed from the list and click on the OK
button. Device drivers are copied to their corresponding
directories.
Click on the Exit button, then the Yes button. If the current
DlSPLAY.DLL is in use, a dialog box will pop up to notify
the user that changes will be in effect on the next reboot.
Click the OK button to exit the installation utility.

3. Modify the CONFIG.SYS file in the root directory so that
OS/2 will install the correct device driver on the next
reboot.
Click on the OS/2 System Editor icon from the Productivity
folder which resides in the OS/2 System folder.
Once in the OS/2 System Editor, click on File Open and
select CONFIG.SYS in the File box. If CONFIG.SYS is not
displayed, type in the correct path and file name in the
Filename box (i.e., C:\CONFIG.SYS). Click on OK.

Search for the command line which contains the library
path and add the following subdirectory to the beginning
of the path statement.
For example, LIBPATH=C:\CLl6DRV;  . ; . . . . . . .

Select Open from the File menu. Open CONFIG.SYS from
the root directory.
Search for the command line which contains vvga.sys. For
example, DEVICE=C:\OS2\MDOS\VVGA.SYS.  Select
Find from the Edit menu.
Type VVGA.SYS in the Find: edit box.
Uncheck the Case Sensitive option if it is checked.
Click on the Wrap option so that a tick mark appears in the
check box.
Click on the Find button.
Once the command line is located, select the C a n c e l
button.
Highlight the command line with the mouse, then select
Copy from the Edit menu.
Click at the end of the command line, press the [Enter] key
to insert a new line below the current command line. Select
Paste from the Edit menu to make a copy of the command
line.
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Type REM at the beginning of the original command line.
Change VVGA.SYS in the pasted command line to
CLVSVGA.SYS. Select Save from the File menu and save
the changes. Double click on the SYSTEM icon to exit the
editor. Shutdown the system and reboot for the changes to
take effect.

32 Bit 256 Color Drivers

This installation guide assumes the user has installed the
Corrective Service Pack provided by IBM. Also, this
installation assumes the user is familiar with the mouse
interface of the OS/2 2.0 Desktop Shell environment.

1. Save a copy of the DlSPLAY.DLL  in \OS2\DLL.  If you are
currently running OS/2 2.0, open a DOS session by double
clicking on a DOS Full Screen icon from the OS/2
Command Prompts folder. The command Prompts icon is
in the OS/2 System folder. Move to the \OS2\DLL  directory
by typing at the DOS prompt CD \OS2\DLL  [Enter].
Type COPY DlSPLAY.DLL  IBMVGA.DLL  IB [Enter] at the
DOS prompt to make a backup copy of DISPLAY.DLL.
If you are currently running MS-DOS, follow the above
steps for a DOS session to make a backup copy of the
DISPLAY.DLL.
Return to the root directory by typing. CD\ [Enter] and
create a subdirectory in your OS/2 drive.
If you intend to install the 256 color drivers: Type at DOS
prompt> md CL32DRV  [Enter]. Boot OS/2 to continue with
the installation.

2. Invoke OS/~‘S Device Driver Install utility to copy device
drivers from the Driver and Utilities for OS/2 diskette to the
hard disk.

insert the Drivers and Utilities for OS/2 diskette in drive A:.
Double clickon the Device Driver Install icon in the System
Setup folder. The System Setup icon is in the OS/2 System
folder.
Click on the Install button from the OS/2 2.0 Device Driver
Installation pop up window. The Select Device Drivers opo
up window will display a list of device drivers.

To assist in determining what capabilities your monitor has,
refer to the Clmode  section. Select the device driver to be
installed from the list and click on the OK button. Device
drivers are copied to their corresponding directories.
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Click on the Exit button, then the Yes button. If the current
DlSPLAY.DLL is in use, a dialog box will pop up to notify
the user that changes will be in effect on the next reboot.
Click the OK button to exit the installation utility.

3. Modify the CONFIG.SYS file in the root directory so that
OS/2 will install the correct device driver on the next reboot.

Click on the OS/2 System Editor icon from the Productivity
folder which resides in the OS/2 System folder.
Select Open from the File menu. Open CONFIG.SYS from
the root directory.
Search for the command line which contains the library
path and add the following subdirectory at the beginning of
the path statement: For example, LIBPATH=C:\CL32DRV;

.. , . . . . . . . Search for the command line which contains
vvga.sys.
For example, DEVICE=C:\OS2\MDOS\VVGA.SYS.  Select
Find from the Edit menu.
Type VVGA.SYS in the Find: edit box.
Uncheck the Case Sensitive option if it is checked. Click
on the Wrap option so that atick mark appears in the check
box.
Click on the Find button.
Once the command line is located, select the Cancel
button.

Highlight the command line with the mouse, then select
Copy from the Edit menu.
Click at the end of the command line, press the [Enter] key
to insert a new line below the current command line. Select
Paste from the Edit menu to make a copy of the command
line.
Type REM at the beginning of the original command line.
Change VVGA.SYS in the pasted command line to
CLVSVGA.SYS.
Select Save from the File menu and save the changes.
Double click on the SYSTEM icon to exit the editor.
Shutdown the system and reboot for the changes to take
effect.
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Windows 3.0 drivers for OS/2 2.0

This section assumes that the WIN-OS/2 Support has been
installed. If that option has not been selected at the initial OS/2
installation, please use the Selective Install utility that is in the
System Setup folder to first install WIN-OS/2 Support.

1.

2.

3.

4.

If you do not currently have a WIN-OS/2 session running,
start one.
Open a WIN-OS/2 session by double clicking on a
WIN-OS/2 icon from the OS/2 Command Prompts folder.
The Command Prompts icon is in the OS/2 System folder.

Run the Install program to copy the WIN-OS/2 Drivers and
SetRES Utility to the hard disk.
In the Program Manager, choose File Run. Specify the
diskette drive where the Drivers and Utilities for OS/2
Diskette is inserted, and run the install program.

A:\INSTALL  [Enter]

When prompted, specify to copy the files to the
\OS2\MDOS\WINOSZ  directory.

The resolution may now be selected by running the SetRES
Utility. Execute SetRES by double clicking on the SetRES
icon. Use the SetRES utility to select either 16 or 256 colors
and the desired resolution for future Win-OS/2 sessions.

For help on the SetRES utility, select Help from the program
menu.

Ventura Publisher 2.x/3.0

1. Install Ventura Publisher V.2.0  as instructed in the
product’s manual, specifying the Hercules driver.

2. Insert the drivers diskette into Drive B:. Run the installation
program (INSTALL.EXE), and choose the option for the
Ventura Publisher drivers and specify the drive and
directory where you want them copied to (such as A:\).
Ventura Publisher requires that the drivers be installed
from the root directory of a floppy disk in drive A; or drive
B: and then place the diskette in drive A: before
proceeding.
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3. Change to drive A: by typing A: [Enter].
After the A: prompt appears, run the VPDRVZ_O.EXE
program by typing VPDRV2_0  [Enter].

NOTE: VPDRV2 O.EXE can only be executed from the A: drive.-
Follow the step-by-step installation procedure as it
appears on the screen and select one of the following
drivers when prompted:

Cirrus Logic VGA 800x600 16 of 256K colors or
greys.
Cirrus Logic VGA 1024x768 16 of 256K colors or
greys.

Ventura Publisher V. 2.0 is now configured for the selected
screen resolution and 16 color graphics.

WordPerfect 5.0/S l/6.0

To use high resolution modes with WordPerfect 6.0, install the
VESA driver that comes with WordPerfect and configure the
program to use one of the VESA high resolution graphics
modes.

The high resolution WordPerfect version 5.1 driver supplied
with your VGA supports both high resolution text and graphics.
WordPerfect allows graphics and text drivers to be set up
separately, so be sure to install both of these drivers.

To install the WordPerfect high resolution text driver supplied
with your VGA, follow these instructions:

1.

2.

3.

4.

If you have not already done so, install WordPerfect onto
your computer system. Follow the instructions supplied
with WordPerfect.

Run the installation program (INSTALL.EXE), and choose
the option for the WordPerfect drivers and specify the drive
and directory where you want them copied to (such as
C:\WP51).

Start WordPerfect, and go into SETUP by typing [Shift-Fl].

Choose Display [2], then text screen type by pressing [3].
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Move the cursor to where GD542X  appears on the list, and
choose SELECT.

A sub-menu will appear, listing all the choices of
resolutions supported by the text- drivaSdect -the-desired
resolution.

IO install the WordPerfect high resolution graphics driver
supplied with your VGA, follow these instructions:

1.

2.

3.

4.

5.

6.

If you have not already done so, install WordPerfect onto
your computer system. Follow the instructions supplied
with WordPerfect.

Run the installation program (INSTALL.EXE), and choose
the option for the WordPerfect drivers and specify the drive
and directory where you want them copied to (such as
C:\WP51).

Start WordPerfect, and go into SETUP by typing [Shift-Fl].

Choose Display [2], then graphics screen type by pressing
PI .
Move the cursor to where VGA appears on the list, and
choose SELECT.

A sub-menu will appear, listing all the choices of
resolutions supported by the graphics driver. Select the
desired resolution.

WordStar 5.Y7.0 2000 V. 3.5

1. If you have not already done so, install WordStar onto your
computer system. Follow the instructions supplied with
WordStar.

2. Run the installation program (INSTALL.EXE), and choose
the option for the WordStar drivers and specify the drive
and directory where you want them copied to (such as
C:\WS).

3. Using a text editor enter the file FONTID.CTL in the
WordStar directory and change the CRT TYPE line to-
read:

CRT TYPE=CLSOO.WGD-
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4. When WordStar is executed, the display driver will be used
for page preview mode.

Table 6-l. Standard Video Modes

1 NOTE: Vertical Frequency =70Hz
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Mode
No.

14

54

55

58,6A

58,6A

58,6A

5c

5c

5c

5D+

5D

5D

SD

5F

5F

60+

60

60

60

64

64

65

65

66

66

67

6C+

6D+

6F

70

71

74+P

VESA
No.

-

10A

109

102

102

102

103

103

103

104

104

104

104

101

101

105

105

105

105

111

111

114

114

110

110

113

106
-

10E

IOF

112
-
-

No. of
Colors

- -
16/256)<

16/256K

16/256K

16/256K

16/256K

16/256K

256/256K

256/256K

256/256K

16/256K

16/256K

16/256K

16/256K

256/256K

256/256K

256/256K

256/256K

256/256K

256/256K

64K

64K

64K

64K

32k*

32K*

32K*

16/256K

256/256K

40x25

16M

16M

64K-

Char. x
Row

Char.
Cell

Screen
Format

132x25 8x16

132x43 8x8

132x25 8x14

100x37 8x16

100x37 8x16

100x37 8x16

100x37 8/16

100x37 8x16

100x37 8x16

128x48 8x16

128x48 8x16

128x48 8x16

128x48 8x16

80x30 8x16

80x30 8x16

128x48 8x16

128x48 8x16

128x48 8x16

128x48 8x16
- -

- -

- -

- -

- -

- -

- -

160x64 8x16

160x64 8x16

8x8 8x8

40x25 8x8

80x30 8x16
- -
Pv

1056x400

1056x350

1056x350

800x600

800x600

800x600

800x600

800x600

800x600

1024x768

1024x768

1024x768

1024x768

640x480

640x480

1024x768

1024x768

1024x768

1024x768

640x480

640x480

800x600

800x600

640x480

640x480

800x600

1280x1024

1280x1024

320x200

320x200

640x480

1024x768-

Pixel
Freq.
(MHz)

41.5

41.5

41.5

36

40

50

36

40

50

44.9

65

75

77

25

31.5

44.9

65

75

77

50

63

72

80

50

63

72

75

75

25

38

75

44.9

Horizontal
Wquency

(KHz)
31.5

31.5

31.5

35.2

37.8

48.1

35.2

37.9

48.1

35.5

48.3

56

58

31.5

37.9

35.5

48.3

56

58

31.5

37.9

35.2

37.8

31.5

37.9

31.5

48

48

31.5

31.5

31.5

35.5-

Vertical
bquenzy
(Hz)

70

70

70

56

60

72

56

60

72

87+

60

70

72

60

72

87+

60

70

72

60

72

56

60

60

72

56

87+

87+

70

70

60

87+P

Table 6-2. Extended Video Modes
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NOTE: 1. Only Mode No. 14, 54, 55 are in Text Display Mode.
2. Some modes are not supported by all monitors. The
fastest vertical refresh rate for monitor type selected will
be automatically used.
3. Lb*99 character stands for 32K Direct-Color / 256-color
Mixed Mode.
4. “+” character stands for Interlaced Mode.
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Appendix A
Hard Disk Specifications

CONNER

MODEL CAPACITY

CP-30084 85MB

CP-30084E 85MB

CP-30104 WOMB

CP-30104H WOMB

CP-30174 170MB

CP-30174E 170MB

CP-30204 200MB

CP-30204F 200MB

CP-30254 251 MB

CP-3364 360MB

CP-3544 544MB

CYLINDER HEAD SECTOR

526 a 39

526 8 39

726 8 39

726 a 39

903 8 46

903 a 46

683 16 38

683 16 38

895 10 55

702 16 63

1024 16 63

MAXTOR

MODEL CAPACITY CYLINDER HEAD SECTOR

7120A 12OMB 1023 14 17

7170A 170MB 964 10 34

7213A 213MB 683 16 38

7245A 245MB 967 16 31

7345A 345MB 790 15 57ir 1

Hard Disk Specifications




